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知識ユニット

• MieruPC-2008 ハードウェアのセットアップ（１０分）

• MieruPC-2008 ハードウェアの動作確認（１０分）

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．



3
MieruPC 
Project 

MieruPC-2008の内容

電源ケーブル

USB
電源ケーブル

SDカードディスプレイケーブル

キーボード

本体とディスプレイ
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添付される２枚のSDカードについて

• アプリケーションのシールが添付されたSDカード１枚

– アプリケーションが保存されています．MieruPC-2008に挿入して実
行を確認してください．

• シールが添付されていないSDカード１枚

– データが保存されていないSDカードです．

– アプリケーションは保存されていません．作成したアプリケーションを
コピーしてご利用ください．

• MieruPC-2008では8MBのSDカードのみが利用可能です．
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（１） ディスプレイケーブルを接続しましょう．
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（２） 電源ケーブルを接続しましょう．

• 電源ケーブルには，コンセントに接続するタイプと，USBに接続するタイ

プに２種類があります．どちらも同様に電源を供給できます．

• ノートPCなどから電源を取るためにUSBタイプを利用すると便利です．
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（３） スイッチオン

電源スイッチ

リセットボタン

7
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（４） アプリケーションの入ったSDカードを挿入

リセットによりアプリケーションが起動
（製品版には特別ゲームが付属）

キーボードコネクタ
（キーボード入力が
必要な場合には接続）



9
MieruPC 
Project 

本体とディスプレイは固定できます

• 付属のネジとナットを使って，本体とディスプレイを固定でき
ます．強くネジを締めすぎないでください．
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FPGA開発のためのMieruPC-2008 ハード

ウェアのセットアップ

FPGAFPGA開発のための開発のためのMieruPCMieruPC--2008 2008 ハードハード

ウェアのセットアップウェアのセットアップ
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知識ユニット

• FPGA開発のためのMieruPC-2008 ハードウェアのセット

アップ（２０分）

– MieruPC-2008に搭載されているFPGA (Field 
Programmable Gate Array) に独自開発の回路をコンフィ

ギュレーションする場合に必要となる設定です．

– CPUの構成変更やFPGA開発が必要ではない場合にはこの

設定は不要です．

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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Digilent USBケーブルと接続ケーブル

• Digilent USBケーブル （左）

– パソコンのUSB端子とFPGAとを接続するケーブルです．

– 精密機械です．取り扱いに十分注意してください．

• MieruPC-2008用の接続ケーブル（右）

– Digilent USBケーブルをMieruPC-2008のFPGAに接続するため

の変換ケーブルです．

Digilent USBケーブル

MieruPC-2008用の接続ケーブル



13
MieruPC 
Project 

コンフィギュレーション用ケーブルの接続

• Digilent USBケーブルのVDDとMieruPC-2008用の接続

ケーブルの赤い線が揃う様に接続します（下図参照）．

• MieruPC-2008用の接続ケーブルをSUZAKUに図の様に

接続します．
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オプションのSUZAKU JP2 の設定

• この作業は通常は必要ありません．

– 電源投入後にSPIフラッシュメモリから自動でFPGAにコンフィ
ギュレーションすることを禁止したい（電源投入後にMieruPC
のコンフィギュレーションを停止したい）場合には，SUZAKU 
JP2 をショートしてください．

– 具体的には，JP2 にジャンパーピンを取り付けます．
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コンフィギュレーション用ケーブルを接続の補足

• コンフィギュレーション用ケーブルを接続するためには，
MieruPC-2008基板をケースから取り外す必要があります．

• ケース裏の４つのネジを外して，基板をケースから取り出し
て作業をおこなってください．
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SUZAKUのLEDを点滅させる (sample01)SUZAKUSUZAKUののLEDLEDを点滅させるを点滅させる (sample01)(sample01)
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知識ユニット

• Xilinx ISE の使い方の基礎 （3０分）

• Verilog HDL記述の基礎 （1０分）

• Digilent ExPortの使い方の基礎 （１０分）

• MieruPCを用いた動作検証の基礎 （１０分）

• 演習 （３０分）

Xilinx ISE, Digilent ExPort のインストールが終了していること．
MieruPC-2008とコンフィギュレーションケーブルの設定が終わっていること．

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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Xilinx ISEにてプロジェクトを新規作成(1)

• Xilinx ISEを起動する．

• File -> New Project
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Xilinx ISEにてプロジェクトを新規作成(2)

• New Project Wizard が起動する．

• この画面にてプロジェクト名 sample01 を指定
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Xilinx ISEにてプロジェクトを新規作成(3)

• デバイス名などを正しく設定する．



21
MieruPC 
Project 

Xilinx ISEにてプロジェクトを新規作成(4)

• ソースコードは後に追加するのでここでは設定しなくてよい．
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Xilinx ISEにてプロジェクトを新規作成(5)

• 確認画面．Finish をクリックする．
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Xilinx ISEにてプロジェクトを新規作成(6)

• xc3s1200e-4fg430 として登録される．
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Verilog HDLソースコード main.v の追加 (1)

• Project -> New Source 
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Verilog HDLソースコード main.v の追加 (2)

• テキストエディタにて記述するので，ここでポート名などを追
加しなくてもよい．
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Verilog HDLソースコード main.v の追加 (3)

• main.v が追加される．
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Verilog HDLソースコード main.v の編集(1)

module main(CLK, ULED);
input  CLK;
output ULED;
reg [31:0] cnt;
assign ULED = cnt[20];

always @(posedge CLK) begin
cnt <= cnt + 1;

end
endmodule

CLKは，3.6864MHz の入力クロック
ULEDは，ユーザ制御のLED
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Verilog HDLソースコード main.v の編集(2)

• ソースコードを記述
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UCFファイル main.ucf の追加 (1)

• Project -> New Source
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UCFファイル main.ucf の追加 (1)

• Implementation Constraints File（UCFファイル）を選択する．

• ファイル名 main.ucf を指定する．
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UCFファイルの編集(1)

• main (main.v) の左の + をクリックすることで，main.ucf が

現れる．
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UCFファイルの編集(2)

• User Constraints の左の + をクリックすることで，Edit 
Constraints (Text) が表示される．
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UCFファイルの編集（３）

• Edit Constraints (Text) をダブルクリックして編集する．

• エディタ画面にて，CLK, ULED のピンを指定する．
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論理合成，実装，プログラミングファイルの作成

• main (main.v) を選択する．

• Generate Programming File をダブルクリックする．

– プログラミングファイルの作成，時間を要することがある．
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FPGAのコンフィギュレーション(1)

• Digilent ExPort を起動する．

• Initialize Chain でデバイス (XC3S1200E) を認識する．

エラーが表示される場合には，ハードウェアの接続，電源が投
入されているか，などを確認すること．
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FPGAのコンフィギュレーション(2)

• Browse -> main.bit を選択

• はい (Y) を選択
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FPGAのコンフィギュレーション(3)

• コンフィギュレーションが完了する．エラーが表示される場
合には，ハードウェアの接続などを確認すること．
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MieruPCを用いた動作検証

• FPGAボード(SUZAKU)の赤色LED(発光ダイオード，
Light Emitting Diode)が点滅する．
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演習問題(1)

module main(CLK, ULED);
input  CLK;
output ULED;
reg [31:0] cnt;
assign ULED = cnt[21];

always @(posedge CLK) begin
cnt <= cnt + 1;

end
endmodule

Verilog HDLの記述を右に変更するとLEDの点滅はどのように変化するか．

修正して確認すること．
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演習問題(2)

• 入力のクロックは 3.6864MHz である．

• １秒の周期でLEDが点滅を繰り返す様にVerilog HDLを修

正せよ．

• ハードウェアを用いて，点滅の周期が正しいことを検証せよ．
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GPIOを用いたLEDの点滅 (sample02)GPIOGPIOを用いたを用いたLEDLEDの点滅の点滅 (sample02)(sample02)
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知識ユニット

• MieruPC-2008 GPIOの使い方の基礎 （２０分）

• シンプルな拡張ボードの実装 （２０分）

「SUZAKUのLEDを点滅させる (sample01)」 を学習済みであること．

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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MieruPC-2008の汎用I/O (GPIO)

• 16本のGPIO, VDD 5.0V, VCC 3.3V, GND

GPIO[1]
GPIO[3]

GPIO[5]

GPIO[7]

GPIO[9]

GPIO[11]

GPIO[13]

GPIO[15]

VDD 5.0V VCC 3.3V

GNDGND

GPIO[2]
GPIO[4]

GPIO[6]

GPIO[8]

GPIO[10]

GPIO[12]

GPIO[14]

GPIO[16]
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UCFファイル main.ucf の編集

#### GPIO(CPU) ####
NET GPIO[1]   LOC="N5";  # SUZAKU CON2-07
NET GPIO[2]   LOC="N4";  # SUZAKU CON2-08
NET GPIO[3]   LOC="M6";  # SUZAKU CON2-09
NET GPIO[4]   LOC="M5";  # SUZAKU CON2-10
NET GPIO[5]   LOC="M3";  # SUZAKU CON2-11
NET GPIO[6]   LOC="M4";  # SUZAKU CON2-12
NET GPIO[7]   LOC="L5";  # SUZAKU CON2-13
NET GPIO[8]   LOC="L6";  # SUZAKU CON2-14
NET GPIO[9]   LOC="L4";  # SUZAKU CON2-15
NET GPIO[10]  LOC="L3";  # SUZAKU CON2-16
NET GPIO[11]  LOC="L2";  # SUZAKU CON2-17
NET GPIO[12]  LOC="L1";  # SUZAKU CON2-18
NET GPIO[13]  LOC="C9";  # SUZAKU CON2-20
NET GPIO[14]  LOC="D9";  # SUZAKU CON2-22
NET GPIO[15]  LOC="K5";  # SUZAKU CON2-23
NET GPIO[16]  LOC="K6";  # SUZAKU CON2-24

• 汎用I/O(GPIO)は GPIO[16:1] として利用する．

• main.ucf を編集して以下を追加する．
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MieruPC-2008の汎用I/O (GPIO)

• GPIO[11] を 0V に設定する．

• GPIO[15] を制御することでLEDを点滅させる．

GPIO[1]
GPIO[3]

GPIO[5]

GPIO[7]

GPIO[9]
GPIO[11]

GPIO[13]

GPIO[15]

VDD 5.0V VCC 3.3V

GNDGND

GPIO[2]
GPIO[4]

GPIO[6]

GPIO[8]

GPIO[10]

GPIO[12]

GPIO[14]

GPIO[16]

LED

３００Ω程度



46
MieruPC 
Project 

Verilog HDLソースコード main.v の編集

module main(CLK, ULED, GPIO);
input  CLK;
output ULED;
output [16:1] GPIO;
reg [31:0] cnt;
assign ULED = cnt[20];

assign GPIO[11] = 0;
assign GPIO[15] = cnt[19];

always @(posedge CLK) begin
cnt <= cnt + 1;

end
endmodule

sample01 の main.v をベースに修正．

CLKは，3.6864MHz の入力クロック
ULEDは，ユーザ制御のLED
GPIOは，汎用I/O
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論理合成，実装，プログラミングファイルの作成

• sample01 をベースに main.v と main.ucf を編集し，プロ

グラミングファイルを作成する．
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MieruPCを用いた動作検証

• ユニバーサル基板を用いて拡張ボードを実装する．

拡張ボード（表）

拡張ボード（裏） コンフィギュレーションして動作確認をおこなう．
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リセット付きのLED点滅回路 (sample03)リセット付きのリセット付きのLEDLED点滅回路点滅回路 (sample03)(sample03)
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知識ユニット

• MieruPC-2008 リセットスイッチの使い方 （２０分）

「SUZAKUのLEDを点滅させる (sample01)」 を学習済みであること．

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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UCFファイル main.ucf の編集

NET RST_X     LOC="A14"; 

• リセット信号 RST_X を追加する．
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Verilog HDLソースコード main.v の編集

module main(CLK, RST_X, ULED);
input  CLK;
input  RST_X;
output ULED;
reg [31:0] cnt;
assign ULED = cnt[20];

always @(posedge CLK or negedge RST_X) begin
if(!RST_X)

cnt <= 0;
else

cnt <= cnt + 1;
end

endmodule

sample01 の main.v をベースに修正．

CLKは，3.6864MHz の入力クロック
ULEDは，ユーザ制御のLED
RST_Xは，リセット信号



53
MieruPC 
Project 

MieruPCを用いた動作検証

• FPGAボード(SUZAKU)の赤色LED(発光ダイオード，
Light Emitting Diode)が点滅する．

• リセットスイッチを押すと，リセットされ，LEDが点灯する．
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ブザーの取り付けと利用方法 (sample06)ブザーの取り付けと利用方法ブザーの取り付けと利用方法 (sample06)(sample06)
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知識ユニット

• ブザーと抵抗の取り付け （20分）

• ブザーの使い方 （20分）

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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ブザーの取り付け（オプションです）

• MieruPCのマザーボードにはブザーを取り付けることができます．

– 秋月電子商会 電子ブザー [HDB06LFPN] を想定しています．

– 33Ω程度の抵抗が必要です．

• 33Ω程度の抵抗を接続してください．

• ブザーを取り付けます．極性があるので注意してください．下図では，
右がプラス，左がマイナスです．

＋-
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Verilog HDLソースコード main.v と ucfファイル

module main(CLK, RST_X, ULED, BUZ);
input  CLK;
input  RST_X;
output ULED;
output BUZ;

reg [31:0] cnt;
assign ULED = cnt[20];
assign BUZ =  cnt[20] & cnt[19] & cnt[18] & cnt[17];

always @(posedge CLK or negedge RST_X) begin
if(!RST_X)

cnt <= 0;
else

cnt <= cnt + 1;
end

endmodule

NET CLK       LOC="U10"; 
NET RST_X     LOC="A14"; 
NET ULED      LOC="T3"; 
NET BUZ       LOC="K12";

BUZを１とすることでブザーが鳴ります．
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PS/2キーボードからの入力 (sample04)PS/2PS/2キーボードからの入力キーボードからの入力 (sample04)(sample04)
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知識ユニット

• PS/2接続キーボード（シリアル転送）の理解 （60分）

• シンプルなキーボードモジュールの実装 （60分）

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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PS/2キーボードコネクタ（Mini-DIN 6ピン）

• 1 : KEY_IN
• 3 : GND
• 4 : 5V
• 5 : KEY_CLK

1 (KEY_IN)2

3 (GND)

4 (5V)

5 (KEY_CLK)

6

4 (5V) 3 (GND)

1 (KEY_IN)5 (KEY_CLK)
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PS/2キーボードからシステムへの信号

St(0) D0 D1 D2 D3 D4 D5 D6 D7 Pa Sp(1)

• KEY_CLK, KEY_IN はキーボードが生成する点に注意．

• 入力データはクロックの立ち下がりで取得する．

KEY_CLK

KEY_IN
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Ps2keyboardモジュールのタイミングとインタフェース

St(0) D0 D1 D2 D3 D4 D5 D6 D7 Pa Sp(1)

KEY_CLK

KEY_IN

dataKEY_DOUT

KEY_READY

negedge ps2_clock

PS2KBD

module PS2KBD01(RST_X, KEY_CLK, KEY_IN, KEY_DOUT, KEY_READY)
input RST_X, KEY_CLK, KEY_IN;
output [7:0] KEY_DOUT;
output KEY_READY;

RST_X
KEY_CLK
KEY_IN

KEY_DOUT
KEY_READY
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Verilog HDLソースコード main.v の編集

module main(CLK, RST_X, ULED, KEY_IN, KEY_CLK);
input  CLK;
input  RST_X;
input  KEY_IN;   // Keyboard input data
input  KEY_CLK;  // Keyboard input clock
output ULED;

reg led;

wire key_ready;
wire [7:0] key_dout;
assign ULED = led;

always @(posedge CLK or negedge RST_X) begin
if(!RST_X) led <= 0;
else if(key_ready) begin

if(key_dout==8'h1c) led <= 1; // 'A' is pushed
if(key_dout==8'h32) led <= 0; // 'B' is pushed

end
end

PS2KBD01 ps2kbd(RST_X, KEY_CLK, KEY_IN, key_dout, key_ready);
endmodule
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Verilog HDLソースコード keyboard.v の編集
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UCFファイル main.ucf の編集

NET CLK       LOC="U10"; 
NET ULED      LOC="T3"; 
NET RST_X     LOC="A14";

NET KEY_IN    LOC="A16" | IOSTANDARD=LVTTL | SLEW=SLOW; 
NET KEY_CLK   LOC="C14" | IOSTANDARD=LVTTL | SLEW=SLOW;  
NET KEY_CLK   CLOCK_DEDICATED_ROUTE = FALSE;
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MieruPCを用いた動作検証

• キーボードのAを押すと，FPGAボード(SUZAKU)のLEDが
消える．

• キーボードのBを押すと，FPGAボードのLEDが点灯する．
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補足

• PS/2キーボードは，キーが押されたときにメークコードを出

力し，キーが離されたときにブレークコードを出力する．

• if(key_dout==8‘h1c) led <= 1;  のコードは，Aのメーク
コード 8’h1c が得られた時に，LEDの出力を変更する．

• メークコードとアスキーコードは対応しないので注意が必要．

• 実用的なキーボードコントローラとして利用するためには，
アスキーコードへの変換，チャタリング対策などが必要です．
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液晶モジュールのテスト (sample05)液晶モジュールのテスト液晶モジュールのテスト (sample05)(sample05)
Version 2009Version 2009--0505--25  25  

吉瀬謙二吉瀬謙二 （東京工業大学）（東京工業大学）
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知識ユニット

• 液晶モジュールの使い方 （６０分）

このスライドは，講義および演習などのために自由に利用することができます．
ただし，スライドに含まれる画像などの取り扱いには注意してください．
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Verilog HDLソースコード main.v の編集

`define LCDPUT_WAIT 1000000
module main(CLK, RST_X, ULED, LCD);

input  CLK, RST_X;
output ULED, LCD;

reg [31:0] bcnt; // counter for LCDPUT module
reg [7:0]  data; //
reg WE;

wire ready;
assign ULED = ready;

always @(posedge CLK or negedge RST_X) begin
if(!RST_X) begin

WE    <= 0;
bcnt <= 0;
data  <= 8'h40;

end else begin
bcnt <= bcnt + 1;
if(bcnt>`LCDPUT_WAIT && ready) begin

data <= data + 1;
WE   <= 1;
bcnt <= 0;

end else if(WE) WE <= 0;
end

end

LCDPUTC lcdc(CLK, RST_X, data, WE, ready, LCD);
endmodule
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Verilog HDLソースコード lcdput.v の編集(1)
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Verilog HDLソースコード lcdput.v の編集(2)
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MieruPCを用いた動作検証

• 液晶モジュールにA,B,C … という文字が表示される．

• リセットにより画面がクリアされる．


